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1. B=E

1.1 BHB®Y

e? studio . Eclipse 2X—R & LE=#HARREIE T, BALBA—ToY—RY DI b9z 7DTS554
VEHAAAT, HEEZEBM HERT A EMTEET,

CUnit [, C TEHATR i, BB, BLUETTHLODIATLTY, A—F—DTFRX +a—F
22D T B-0DEFMSATSVELTEBELET., TRIMEEEBETI-HDOL U TLETL—L4A
D—0%FAL., —BHLET—ARETANTE-OOEELTH—avty FEREH#HELET, 512,
TAMETHBROLEAR— MEBRD=606DA V23— —XLEHLTVET,

ZDORXa1 A2 FTIX, e?studio LT CUNit #FERALE-BEATRA FOERAEICOVTEHBALET,

1.2 ENMEHERIRIR

CORFa A THATDHEEFIRIZONTIE, BHICTUTORETHERZERBLTVET, =1
L. A—ToY—ZRDY I+ 27 EDEZEICHYETDOT, BULBEZRIETHLDOTREHY FEA,
HoMLOITHROEBSEVBELETES,

[0S]
« OS Windows10 (BAEEhR)
[v—I]
» e?studio 2022-04
e CUnit 21.2
2= /4
FlELTUTOTNAR, BLUY—ILFz—UFEELETAD Y FEFERLET,
i FINA R RX610
e Y—J)LFI—V CC-RX V3.04
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2. Ty b7y
CHETIE. CUnitEA VR =L LTEY F7Y T BFIBEICDOLVTHALET,

CEEEIA]

e CUnit21-2%&4ooO0—FLTHEALTLLEEL, EFHRTHS CUit-2.1-3 IZIF L DO DOREE
RHYEIRIS—DREETHEENHY FT,

e OaVUNAT (LU Windows VAT L) [E., Tcurse] EPa—ILEHYR—FLEEA.

21 CUnitzA4 YA +—ILT B

CUnit & Thttps://sourceforge.net/projects/cunit/files/CUnit/] S FH > A—KLET, EHEI 7M1 ILE#E
HELT, FEO 74 IILFIZCUnit v sr—CH#RBRALET,

22 CUnit 51473 &%E/T S

CUnit &, 21— —Da—FIZ) V9T BHMSA TS5 ELTHEETIDENHYET, CUnitDS 4
JsyJaszy bEERLT. SATS5YEERLET,

1) A=a— [Z74IF)] > [#FHHN)] > [Renesas C/C++ Project] > [Renesas RX] Z#EIRLFT,

2) [New C/C++ Project - Templates for New C/C++ Project] 44 7RI ARRINFEFT, AV R LRy
49 AT lRenesas CC-RX C/C++ Library Project] Z#IRL T, [RAN)>] R22&#0UvoLE
Jo

« New C/C++ Project O X

Templates for Renesas RX Project

Renesas CC-RX C/C++ Executable Project ~
C/C++ FE==™ A G/C++ Project for Renesas RX using the Renesas CCRX toolchain.

Renesas CC-RX C/C++ Library Project
===~ A (/C++ Library Project for Renesas RX using the Renesas
CCRX toolchain.

&)
il
N

= 1
3) [New Renesas CC-RX Library Project - New Renesas CC-RX Library Project] &4 7RI &R RrIh
9, [PV +4AP)] wERY Y XIZ TCUnit] ZAALT, [RAN)>] RE2EH YYD
Lij—o
4) [New Renesas CC-RX Library Project - Select toolchain, device & debug settings] %4 7 BJ MNKRR
NEST., TRERERELET . BRYDEMIE. TIAHILMDFEFELFET, REERT LG [#T
Rl R2>&0UvILET,

e [Y—IFz—r:] avERKRyY X : Renesas CCRX

e [W—ILFI—r -N—U32:] aVvARRY IR EE (ZOFRF1 A2 RTIE 1v3.04.00] %:&#
R)

s [T Ybr-TNRAR] BERYIR 8 (2O FF2 42 bTIE TREF56107VXFP1 Z3#E4R
[RX600 > RX610 > RX610 - 144pin > R5F56107VxFP] )
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¢ O X

New Renesas CC-RX Library Project prm—

Select toolchain, device & debug settings

Toolchain Settings

== @®C OC++
J-IFI-: Renesas CCRX ~
Y=NF1-2- (-3 v3.04.00 ~
YNFI-VOEE .
Device Settings Configurations
Target Board: | Custom V| Debug EREER

Download additional boards... [] Release 5% 5k

H—#y -7 ]84 A: |RSF56107VXFP .
TIAZDTY09Y...
IUTAT Y Litile ~
JOITI-547: 7 IAlb

@ < E3(8) RAN) > £70 Frvtl
2

5) Library 7Bz bAMERESAT, [FRP Y b - THRTO—5—] Ea—IZ, CUnit 7>z
EARTENET, TIAILEDY—RIT7AIILIEIRHELR =0, Tsrcl ZHILEADT 74 )L
(sample1.c, sample2.c, sample3.S) ZHIBRELET,

6) CUnit/Sys—SA VA R—=ILLETHILED TCUNit] Z+ILAFI2HBD. [¥Headers) .
l'¥Sources¥Basic] & U ¥Sources¥Freamwork] % CUnit 7B x4 +® Tsrcl 74 A~AOE—
LET,

Ty ME. ROKSIZHRYFET,

M JOYIHR-TH92T0-5- X
v |25 CUnit [Debug]
m Includes
v B3 src

& Basic
& Framework
& Headers

X 3

7) [FR Y b THRTA—5—] Ea—TCUnit7AS Y FEERLT, aVTFA M- A
— 11— [C/C++ Project Settings Ctrl+Alt+P] &R L E T,

8) [Fm/XFT«:CUnitl] 47K TINET, [YV—IEE] 2TDY1)—T Compiler> V—

Al EBERLES., [M1VIL—F-T74LERET DT HILHA (-include)] YR bRy R
F${workspace_loc:/${ProjName}/src/Headers}] ZEBMLFET .
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e JO/{74: CUnit

= MRS
Yy-2 A
v C/C++ EILF
A BEE Configuration: | Debug [79717] BROSE.
Y=WFIAY-I74%
FlLFzy .
nEvs ® U-VEXE Toolchain Device & PJLF-ZTv7 D EILFmEY KAFU—)-9- @ I5—- /-9
=5 ~ ® Common AV~ TP VEBTT SIS (-include) L R
B & cry ${TCINSTALL}/include
C/C+ —i8 & PIC/PID “${workspace_locy/${ProjName}/src/Headers}”
Renesas QE & 20k
Task Tags ~ 1§ Compiler
Validation v BY-Z
EILT- gt
TDv:I?h-JF—T?— & ATIIH
7oJrsteR & YAk
ETINVIRE v & B
< > i 7R v
@ EALTELS Fovtl

9) [Y—ILB®E] 2 TDYV')—T Compiler> V—2R > #53k] Z:ERLET,
RARYHORT TCI9 &) #&EIRLET,

e JO/T4: CUnit

10) MHeaders] A I AFIZTFTRABD I 74 ILEER L TEMLET,

[F1h5AN || e
YY-2 ~
v C/C++ EILF o -
PE Configuration: |Debug (74747
U=NFI42 15
(@[
oxys ® Y-)VBE Toolchain Device
i v & Common
BE @ CPU
C/Cr+ —fi @ PIC/PID
Renesas QF 3 Z0ith
Task Tags v B Compiler
Validation v @ Y-2
Eng- & 3R
JOYTk R-Fr- & ATV
< " B 02
@

= 4

£ EWR-RFYS
=2 (-lang)
C++Y=2 (-lang (C++))

TOYSLMFI-F (-euc/-sjis/-latin1/-utf8/-big5/-gb2312) UTF-81-F

EREEFIVITS (-check)

EIVERRS b A1F)--/-%- @ I5-)-Y-

COIMEE
C++RIE

WLz

AVTAA=2IY Ay P-UDH D EIIETS (-message/-nomessage)

HAOEMET 5Ly - Y85 (-nomessage)

[N9A==u dytt-SOMFNEA Y IA A= 23U EE TS (-chanae message=information)

MALTMLS et

® 5

[CY—X (dang)] >
EALTCEALS] R22 & 0y LET,

V| HROWE..

(CC-RX %, time.h ZH R—FLTWEBADTEI—DI7AMILEERTILENHY ETT)

o time.h

#ifndef
#define

typedef
#define
#define

#endif
/* TIME

TIME H_
TIME H_

int clock _t;

CLOCKS_PER_SEC 1000

clock () (0)

_H O/
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1) [z b IHRTO—-5—] Ea—TCUnit 7AY Y FEREIRLT, AVTFA L - 4
Za— [FE2V FOEIKB)] #BIRLET, EILFARITSN, [Debugl 7+ IILFIC
[CUnitlib] Z 74 ILARFESNET,

M JOY150-I52370-5- X
v [g% CUnit [Debug]
n) Includes
&8 src
v (& Debug
& sic
| CUnit_lud
CUnit.lbp
loip CUnitlib
CUnit.udm
LinkerCUnit.tmp
LinkerSubCommand.tmp
» makefile
makefile.init
® object.mk
udSubCommand.tmp
CUnit.repe

X 6

CUnit 547351 - Z74)L TCUnitlib] (&, CUNt TR I L—LD—V #RELEFT, R—a 2/
150780 FTHNIE, EOQCIC+TRAD LY FTHERATHIENTEET,
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3. ERAE

COETIE. CUNt 2EEALEFR F2EF$T2T05 15 FOERSE. BEUTFR FOEFHEIZD
WTHBALET,
31 FRMAETOD Y FEERT S

1)

TR & FTOT 5 kL, Renesas CC-RX C/C++ Executable Project & L TR L ET,

AZa— [Z74IF)] > [#HH(N)] > [Renesas C/C++ Project] > [Renesas RX] #ERLFET,

2) [New C/C++ Project - Templates for Renesas RX Project] 44 7RI NRTENFET, AU Rk
7R 2 AT IRenesas CC-RX C/C++ Executable Project] ZZ#IRLET., [RAN)>] K2 %5
Dy LFET,

e New C/C++ Project O X
Templates for Renesas RX Project
Renesas CC-RX C/C++ Executable Project ~
C/C++ FE==N A G/C++ Project for Renesas RX using the Renesas CCRX toolchain.

Renesas CC-RX C/C+ + Library Project

FE==N A C/C++ Library Project for Renesas RX using the Renesas
CCRX toolchain. .
| < >
@ BT Frytl
&’ 7

3) [New Renesas CC-RX Executable Project - New Renesas CC-RX Executable Project] &4 7 B4 hi%k
TEhFET, [PV AP)] wERY Y X2 TSampleCUnit] #AALT. [RAN)>] KA
vEO VI LET,

4) [New Renesas CC-RX Executable Project - Select toolchain, device & debug settings] %4 7 B4 hi%k
REhFET, TRERERELET. BYDEMIEX. TIHILEDFEFELFET, REEKRTLES
[RAN)>] RE2ZEI UV LET,

e [Y—NFz—r:] aviKRKRyY X : Renesas CCRX

e [Y=LFz—r -nN=P32] VKRR IR FE (ZORFa A2 FTIE v3.04.00] %:&E
)

o [B—H5Yb-TNAR] WERVIRX R (ZDFFa A2 FTIE TR5F56107VXFP] %2R
[RX600 > RX610 > RX610 - 144pin > R5F56107VxFP] )

e [Hardware Debug R Z#E/RK] FTv IRV I RADF v I EIET T,

e [Debug #BHZEEM] Fxv IRy IREFzvyy L, RXSimulator] #ERT %,
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¢ O X

New Renesas CC-RX Executable Project —

Select toolchain, device & debug settings o

Toolchain Settings

== @®c Oc++
J-IFI- Renesas CCRX ~
Y=IF1-Y- [{-Y32: | v3.04.00 v
Y-NFI-YOEE
RTOS: None e
RTOS Version:
Device Settings Configurations
Target Board: | Custom ~ | [] Hardware Debug SR F%E K
Download additional boards... E1 (RX) ~

;ST : |R5F56107VxFP
FHb-TIAA: X Debug B EEA

ATV
FIAZDTYOYY... RX Simulator »

IJTATY: |Little v

[ Release BEFER
TOITI-94F: TIAE elease

el

®

5
o
T

= 8
5) [New Renesas CC-RX Executable Project- 3—F 4 >4 - 7YX bY—ILDFR] F4 7 AT HRE
ENFETDT., [RAN)>] RE22EI2V9ILET,

6) [New Renesas CC-RX Executable Project - Settings The Contents of Files to be Generated] %4 7 QO
IHhRR"ENET, [Renesas TNV IREIVY—ILEFERTS] Fzv IRV IREFIvIL
T. [#TF)] K252V 9vILET,
< O X
New Renesas CC-RX Executable Project —
Settings The Contents of Files to be Generated =

T STMBI-FIOER

RenesasT /(w/{EIVY-VEERTS
I/0 ARY—LO)yIFH4 X:
3 >

P
()

<E3(8) RAIN) > #T( ol

X 9

Executable 7OY =¥ rAMERSH., [FOD Y - THRXTO—5—] Ea—IZ SampleCUnit 7
Ay FHRFRSLET,

7) Tsrcl ZAILNFICTERABDI7AILEERLET

. source.h

#ifndef SOURCE H
#define SOURCE H
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int add(int a, int b);
int subtract(int a, int Db);

#endif
/* SOURCE H_ */

® source.c

#include "source.h"
int add(int a, int b) {

return a + b;

int subtract(int a, int b) {
return a - b;

. testsource.c

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <assert.h>
#include "CUnit.h"
#include "source.h"

// This is a test case used to test add() function in source.c
static void test Add 01 (void) {
// Equal Assertion is used in this test case.
// 1 is expected value, and add(1,0) is actual return value.
// If expected value is not same, assertion occurs.
// We can refer the Reference document for the other useful
assertion.
CU _ASSERT EQUAL (1, add(1,0));
}

static void test Add 02 (void) {
CU_ASSERT EQUAL (10, add(1l,9));
}

// This is a test case used to test subtract() function in source.c
static void test Subtract (void) {
// 0 is expected value, and subtract(l,1) is actual return value.
// If expected value is not same, assertion occurs.
CU ASSERT EQUAL (0, subtract(1l,1));
}

// This is a test suite

static CU TestInfo tests Add[] = {
// Register test case to test suite
{"test Add 01", test Add 01},
{"test Add 02", test Add 02},
CU_TEST INFO NULL,

bi
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static CU TestInfo tests Subtract[] = {
{"test Subtract", test Subtract},
CU_TEST_ INFO NULL,

}i

// Declare the test suite in SuitelInfo

static CU_SuiteInfo suites[] = {
{"TestSimpleAssert AddSuite", NULL, NULL, tests Add},
{"TestSimpleAssert SubtractSuite", NULL, NULL, tests Subtract},
CU_SUITE INFO NULL,

}i

void AddTests (void) {
// Retrieve a pointer to the current test registry
assert (NULL != CU get registry());

// Flag for whether a test run is in progress
assert (!CU_is test running());

// Register the suites in a single CU SuiteInfo array

if (CU_register suites(suites) != CUE SUCCESS) {
// Get the error message
printf ("Suite registration failed - %s¥n", CU get error msg());
exit (EXIT FAILURE) ;

}

8) BIEZ 74 /L SampleCUnitc] MAR%E. TR FE2ERTTH-ODTFTiRI—FITEEH®ZFET,
e  SampleCUnit.c

#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include "Basic.h"

void exit (long);

void abort (void);

int main (void);

extern void AddTests () ;

int main(void)

{
// Define the run mode for the basic interface
// Verbose mode - maximum output of run details
CU BasicRunMode mode = CU BRM VERBOSE;

// Define error action

// Runs should be continued when an error condition occurs (1if
possible)

CU ErrorAction error action = CUEA IGNORE;

// Initialize the framework test registry
if (CU_initialize registry()) {
printf ("Initialization of Test Registry failed.¥n");
}
else {
// Call add test function
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AddTests () ;

// Set the basic run mode, which controls the output during test
runs
CU basic_set mode (mode) ;

// Set the error action
CU _set error action(error action);

// Run all tests in all registered suites
printf ("Tests completed with return value %d.¥n",
CU basic_run tests());

// Clean up and release memory used by the framework
CU cleanup registry();
}

return 0;

void abort (void) {}
void exit (long exitcode) {}

9) BIEZ 74 Tsbrk.hl DARZE. TRALEEFTTHODOTRI—FICEEH®RAET,
. sbrk.h

/* size of area managed by sbrk */
#define HEAPSIZE 0x800

10) [FAY Y - ITH9RXRTA—5—] Ea—T SampleCUnit 7R Y FZ&R#IRLT, aVTFX b -
A= a— [C/C++ Project Settings Ctrl+Alt+P] Z:&RLET,

11) [FB/3F «:SampleCUnit] 44 7RI MRRTINET, [V—ILFKE] 2 TDY1)—T Compiler >
Y—R] EZBRLFET, [M12VIL—F - T7MILERETDITHILA (-include)] YR kRv I RIZ
'${workspace_loc:/CUnit/src/Headers}] ZEMLET,

e JO/71: SampleCUnit

o oot
yy-2 ~ ~
v C/C++ EILE
29y TERH Configuration: Debug [F9747] v | EROEE.
Y- FIA Y- 15
[ 1 en — — =
e ® Y-LBE Toolchain Device # FIF-A797 & ELFBR® @ {FY—-/-9— 8 I5— /(-
=5 ~ % Common 990 F- TP NEETT 37205 (-include) B85
% Ay CPU -
. = ${TCINSTALLY/include
C/Cr — R & PIC/PID ${ProjDirPath}/generate

Renesas QF & z0ft “${workspace loc;/CUnit/src/Headers}”
Task Tags ~ & Compiler
Validation v BY-2
ENL5- &g
. W
< T & ATYIh v
@ ERLTELS ool
10
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12) [Y—ILEEFE] 2 TDY)—T lLinker> AN Z&RLET, [(Vov$5)ns5—2T)L-T74
. ZA4TZY) - T7AULEIVNALF1) - T74)L (-input/-library/-binary)] ') X by 2 RIZ
'${workspace_loc:/CUnit/Debug/CUnit.lib}] ZEMLET,

e F0J{74: SampleCUnit

- T
Yy-3 A A
v CfC++ EILE
S Configuration: Debug [FZ747] v | BROEE..
Y-NFI{v-15
ElFEE . e = =
nyy ® U-IZE Toolchain Device & FILF-ATyT FILERRE & MU 8 I3/
ffﬁ ® Common U»FBUDT-97N- 74 4T3 - I7ANEEFIAFY - T2 1)l (-input/-library/-binary) € & &
=E ) & Compiler “${workspace_loc;/CUnit/Debug/CUnitlib}"
C/C+ —i % Assembler
Renesas QE ~ & Linker
Task Tags v & AAH
Validation & R
- ~ @A
. -fn:;‘w—m\-xfa; e & ¥
@ BRALELS Frvel

B 11

13) [V—ILEKTE] 2 TDY1)—T lLibrary GeneratorLinker > ¥ #:&IRLFT., [CEEELSA T
S YBBOER (Hang)] aVRARy I X T TC8IMMEE KU CO9 FRIEHEMN ) #ERLFET, &I,
[ctype.h (C89/C99) : XS 1 TS 1) (-head=type)] Fr v I RwHREFT v LET, 2L
T. [EALTHLS] K450y o LET,

« JO/{74: SampleCUnit

FNIAH o -3

YY-2 N -
~ CfC++ EJLF —
AT Configuration: |Debug [P9747] v EROEE.
J-NFTAY-T5
FllbEs .
0%y ® V-LZE Toolchain Device & FILF-AT97 ELFEREY & FY—-)-8— 8 I7—-/K-H—
fg ® Common CEEEE5(T5UBROBE (lang) |CRIBESSUCoSBE LR .
O’Ci’: —R ? comeller runtime : 7394 Ls- L—F>/ (-head=runtime)
Renesas QF ;g Ali\_sskembler ctypeh (C89/C99) : XFHE{EAF1T3Y (-head=ctype)
Task Tags " :‘D L:Er:rry Generator [Imathh (C89/C99) : FEFHERTFMI5Y (-head=math)
Validation T STF [l mathfh (C89/C99) : $(@EHHATF(T5Y (floatBH) (-head=mathf)
EILg- 2 \A [stdargh (€89/C99) : BEIZEDEZIHTF 7 EARTA T3 (-head=stdarg)
JavIob-F-Fr & ATITHE stdioh (C89/C99) : AEAFFMTFY (-head=stdio)
TR v & EE [ stdiibh (C89/C99) : EEAMEMT(TFY (-head=stdlib) v

el

@ EALTELS

B 12

14) [Pz k- ITH9RTO—5—] Ea—T SampleCUnit 7AY Y FZR#IRLT, aVTFX b -
Az=a— [TAPV FDOEILKB)] EERLET, EILRBEFTEIA. N4 F1U—] THILAFIC
lSampleCUnit.abs] 77 4 JL& TSampleCUnitx] Z 7 A ILARTEINET,

32 CUnit#EHAL-BEARTR FEETT D
1) A=a— [EfTFR)] > [Ty T DEKB)] ZBIRLET,

2) [TNRYTHER] #4705 NRRRENET, [Renesas Simulator Debugging > SampleCUnit
Debugl #&RLT. [T/N\vID)] R22E0UvILET,

3) YIal—ANEELES., »*=1— [Renesas View] > [T/3v 4] > [Renesas Debug Virtual
Console] #ZERLFT,
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4) [Renesas Debug Virtual Console] Ea1—MKRRINFEzT, A =—a1— [ETR)] > [BEWM)] Z#mE

MERT D&
5 UTD&LIIZ.

l'void Excep_BRK(void){ wait(); }1 TTRY S LMEIELET,
[Renesas Debug Virtual Console] Ea1—IZT R MERARTEINET,

= Renesas Debug Virtual Console X

CUnit - A unit testing framework for C - Version 2.1-2
http://cunit.sourceforge.net/

Suite: TestSimpleAssert_AddSuite
Test: test_Add_©1 ...passed
Test: test_Add_©2 ...passed

Suite: TestSimpleAssert_SubtractSuite
Test: test_Subtract ...passed

Run Summary: Type Toteal Ran Passed Failed Inactive
suites 2 2 n/a 2] %]
tests 3 3 3 a [}

asserts 2 2 2 2] n/a

Elapsed time = 08.980 seconds

Tests completed with return value 6.

13 [4—3F)L] Ea—DOTR MERERTR
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4. SEER
41 Web ¥4 k

e e?studio
https://www.renesas.com/software-tool/e-studio
. CUnit

http://cunit.sourceforge.net/

42 HMDTNAR, AVRA45, FERTNYIREREZERT 556

CORFIADKME, CC-RXAYZIaL—LaVREL printf ZHAEHERIEZANRE LRI
BoTWETH, Arm R 7EIFOT /Ny H Tl semi-hosting #EEZ Ik Ya Y —ILHAMNAIRETT,
Fr=, T3 al—4ary—ILHA#EEFREHT=T printf TOHAHAITZ 4 < TH Dynamic printf] % FI|/A
ThEaAVY—ILADRTRIEARETT,

[Dynamic printf] DFERAEIE. FTERER—SODETHTIHREWNETET,

e2studio Tips - Y—RA— FEZEHETS(Z printf T/3\v 53 5H% (Dynamic Printf ZFIBE3 %) |
Renesas

(4511

LUTD&LSHBEED printf Z4E8 L T#FZIZ Dynamic printf] ZHE35&. KRFFX 14 kERBROE
BEBBHIENTEET,

e Xxprintf.h

#ifndef XPRINTF H_
#define XPRINTF H

#define printf xPrintf
void xPrintf (const char* format, ...):;

#endif

e Xxprintf.c

void xPrintf (const char* format, ...);

void xPrintf (const char* format, ...)

{
static char szBuf[512];
va_list ap;
va_start (ap, format);

vsprintf (szBuf, format, ap);

va_end(ap) ; /* here place Dynamic Printf as "%s",szBuf */
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